CHAPTER 1

Troubleshooting

This chapter provides these topics about avoiding and resolving problems related to the switch software:
e Statistics, page 10-2
e Avoiding Configuration Conflicts, page 10-7

e Avoiding Autonegotiation Mismatches, page 10-8

GBIC Security and Identification, page 10-8

Troubleshooting LRE Port Configuration, page 10-9

Troubleshooting CMS Sessions, page 10-11
e Determining Why a Switch Is Not Added to a Cluster, page 10-14
e Copying Configuration Files to Troubleshoot Configuration Problems, page 10-15
e Troubleshooting Switch Software Upgrades, page 10-16
e Recovery Procedures, page 10-18
For additional troubleshooting information:

e See Appendix A, “System Messages,” for information about the system messages sent by the switch
software.

e Refer to the switch hardware installation guide.
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Statistics

This section describes the statistics you can retrieve from the switch and from connected LRE CPE
devices. Use the show controllers ethernet-controller, show remote ethernet-statistics, and show
controllers Ire status privileged EXEC command to display these statistics:

e Table 10-1 for Ethernet port statistics
e Table 10-2 for LRE link statistics
e Table 10-3 for CPE Ethernet link statistics

Table 10-1 Ethernet Port Statistics

Statistic Type

Explanation

Transmit

Unicast frames

The total number of well-formed unicast frames sent by a port. It excludes frames sent with
errors or with multicast or broadcast destination addresses.

Multicast frames

The total number of well-formed multicast frames sent by a port. It excludes frames sent with
errors or with unicast or broadcast destination addresses.

Broadcast frames

The total number of well-formed broadcast frames sent by a port. It excludes frames sent with
errors or with unicast or multicast destination addresses.

Discarded The total number of transmit frames discarded.
Too old The total number of transmit frames discarded because they have exceeded their age limit.
Deferred A count of frames for which the first transmission attempt on a particular interface is delayed

because the medium is busy.

The count represented by an instance of this object does not include frames involved in
collisions.

Excessive collision frames

The total number of frames that failed to be sent after 16 collisions. It includes frames of all
destination address types.

Late collision frames

The total number of frames discarded because of late collisions detected during transmission.
It includes all transmit frames that had a collision after the transmission of the frame's 64th
byte. The preamble and SFD are not included in the frame's byte count.

n collision

The total number of frames that could not be transmitted after n attempts because they
encountered collisions, where n is a number between 1 and 15.

Multiple collisions

The total number of frames that could not be transmitted after multiple attempts because they
encountered collisions.

Deferred frames

Incremented for each frame that was deferred at least once during its transmission attempt
due to collisions.

Carrier sense errors

Incremented every time a carrier is detected during idle.

Pause frames

Incremented for each MAC pause control frame transmitted.
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Table 10-1 Ethernet Port Statistics (continued)

Statistic Type Explanation

Receive

Unicast frames

The total number of well-formed unicast frames received by a port. It excludes frames
received with errors, with multicast or broadcast destination addresses, or with oversized or
undersized frames. Also excluded are frames discarded or without a destination.

Multicast frames

The total number of well-formed multicast frames received by a port. It excludes frames
received with errors, with unicast or broadcast destination addresses, or with oversized or
undersize frames. Also excluded are frames discarded or without a destination.

Broadcast frames

The total number of well-formed broadcast frames received by a port. It excludes frames
received with errors, with unicast or multicast destination addresses, or with oversized or
undersize frames. Also excluded are frames discarded or without a destination.

Discarded frames

The total number of frames discarded because of insufficient receive bandwidth or receive
buffer space or because the forwarding rules stipulate that they not be forwarded.

No bandwidth A count of frames received on this port that were discarded due to a lack of bandwidth
resources in the switch forwarding engine.
No buffers A count of frames received that were discarded due to a lack of frame buffer resources in the

switch forwarding engine.

No destination unicast frames

The total number of well-formed unicast frames that are discarded because the forwarding
rules stipulate that they not be forwarded. This total excludes frames with errors and frames
with multicast or broadcast destination address types or oversize frames and undersize
frames.

No destination multicast
frames

The total number of well-formed multicast frames that are discarded because the forwarding
rules stipulate that they not be forwarded. This total excludes frames with errors and frames
with unicast or broadcast destination address types or oversize frames and undersize frames.

No destination broadcast
frames

The total number of well-formed broadcast frames that are discarded because the forwarding
rules stipulate that they not be forwarded. This total excludes frames with errors and frames
with unicast or broadcast destination address types or oversize frames and undersize frames.

Alignment errors

The total number of frames received with alignment errors. It includes all the frames received
with both an FCS error and a nonintegral number of bytes.

FCS errors

The total number of frames received with FCS errors. It excludes undersized frames with FCS
errors.

Collision fragments

The total number of frames of less than 64 bytes that have an integral number of bytes and
bad FCS values.

Undersize frames

The total number of frames received that were less than 64 octets long (excluding framing
bits, but including FCS octets) and were otherwise well formed.

Minimum size frames

The total number of frames received that were 64 octets long (excluding framing bits, but
including FCS octets) and were otherwise well formed.

Oversize frames

The total number of frames received of more than 1518 bytes that have good FCS values.
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Table 10-2 LRE Link Statistics

Statistic Type Explanation

Upstream bandwidth usage The percentage of the bandwidth used for upstream traffic, based on the current upstream rate
and actual upstream speed of LRE link.

Downstream bandwidth usage |The percentage of the bandwidth used for downstream traffic, based on the current
downstream rate and actual downstream speed of the LRE link.

Signal to noise ratio The amount of increased received signal noise (in decibels) relative to the ambient,
environment, and electromagnetic noise power level that the switch is designed to tolerate
without disconnecting from the remote LRE CPE device. The higher the ratio, the more
resilient the link.

Upstream Reed-Solomon The number of detected and corrected data errors being received on the switch LRE port.
€ITors Reed-Solomon errors result from noise exceeding the noise margin. For short bursts of noise
(such as motor startup or power surges), the Reed-Solomon error correction prevents the loss
of Ethernet data packets.

The LRE interface corrects the data bytes that are incorrectly received on the switch LRE port
(up to a designed 8-byte limit). The residual error rate is better than the detection capability
of the Ethernet cyclic redundancy check (CRC). If the error burst is larger than the correction
capability of the LRE interface, the Ethernet CRC is used to determine the corrupted packets
and to discard them.

Downstream Reed-Solomon | The number of detected and corrected data errors being received on the CPE RJ-11 wall port.
errors
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Table 10-3 CPE Ethernet Link Statistics

Counter Description

Transmit

Bytes The count of octets sent from an LRE CPE Ethernet port.

Dropped frames The count of frames dropped during transmission out an LRE CPE Ethernet port.

Broadcast frames

The count of frames with a broadcast destination sent from LRE CPE Ethernet port.

Multicast frames

The count of frames with a multicast destination sent from an LRE CPE Ethernet port.

Unicast frames

The count of frames with a unicast destination sent from an LRE CPE Ethernet port.

Collisions

The count of frames that could not be sent due to a single collision on the medium.

Multiple collisions

The count of frames that could not be sent due to multiple collisions on the medium.

Deferred frames

The count of frames that could not be sent because the medium was busy

Late collisions

The count of frames that were not sent because a collision happened after 512 bit times into
the transmission of the frame.

Excessive collisions

The count of frames that could not be sent due to excessive collisions.

frame discards

The number of valid frames received that were discarded due to lack of space on an output
queue.

Pause frames

The count of 802.3X pause frames sent out by the LRE CPE Ethernet port.

One collision frames

The total number of frames that could not be transmitted during the first attempt because they
encountered a collision.

Carrier sense errors

The number of times that the carrier sense condition was lost or never asserted when
attempting to send a frame on the Ethernet interface of a CPE device.
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Table 10-3 CPE Ethernet Link Statistics (continued)

Counter Description

Receive

Octets The count of octets received by the LRE CPE Ethernet port.

Undersize frames The count of frames received by the LRE CPE Ethernet port, with size lesser than 64 bytes.

Pause frames The count of 802.3X pause frames received by the LRE CPE Ethernet port.

FCS errors The count of frames received with FCS errors.

Alignment errors The count of frames received with alignment errors.

Oversize frames The count of frames received with size greater than 1518 bytes.

Jabbers The number of frames received by a port that are longer than 1522 bytes and have either an
FCS error or an alignment error.

Dropped frames The count of received frames that were dropped.

Unicast frames The count of received frames that had a unicast destination.

Broadcast frames The count of received frames that had a broadcast destination.

Multicast frames The count of received frames that had a multicast destination

Good octets The count of received octets that had no errors.

Fragments The count of received fragments. Fragments are pieces of a frame.

Excess size discards The count of frames that were dropped because their size exceeded the maximum size.

Source address changes The number of times the source address of good received frames has changed from the

previous value.

Symbol errors The total number of times a valid length frame was received at a port and had at least one
invalid data symbol.

Collisions and runts The total number of frames received whose size is less than 64 bytes.
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Avoiding Configuration Conflicts

Certain combinations of port features conflict with one another. For example, if you define a port as the
network port for a VLAN, all unknown unicast and multicast traffic is flooded to the port. You could not
enable port security on the network port because a secure port limits the traffic allowed on it.

In Table 10-4, no means that the two features are incompatible and that both should not be enabled; yes
means that both can be enabled at the same time and will not cause an incompatibility conflict.

If you try to enable incompatible features by using CMS, CMS issues a warning message that you are
configuring a setting that is incompatible with another setting, and the switch does not save the change.

Table 10-4 Conflicting Features

Connect |Protecte
ATM Port SPAN |Multi-VLAN |Network |to d Port
Port' Port Group Security |Port  |Port Port Cluster?
ATM Port - No No No No No Yes No
Port Group No - No No Yes Yes? Yes Yes
Port Security No No - No No No Yes Yes
SPAN Port No® No No - No No Yes Yes
Multi-VLAN Port No Yes No No - Yes Yes Yes
Network Port No Yes (source-based only) |No No Yes - No* Yes
Connect to Cluster | Yes Yes Yes Yes Yes No - Yes
Protected Port No Yes Yes Yes® Yes No Yes -
1. Catalyst 2900 XL switches only.
2. Cannot be in a destination-based port group.
3. An Asynchronous Transfer Mode (ATM) port cannot be a monitor port but can be monitored.
4. Cannot connect cluster members to the command switch.
5. Switch Port Analyzer (SPAN) can operate only if the monitor port or the port being monitored is not a protected port.
Catalyst 2900 Series XL and Catalyst 3500 Series XL Software Configuration Guide
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Avoiding Autonegotiation Mismatches

The IEEE 802.3u autonegotiation protocol manages the switch settings for speed (10 Mbps or
100 Mbps) and duplex (half or full). Sometimes this protocol can incorrectly align these settings,
reducing performance. A mismatch occurs under these circumstances:

¢ A manually set speed or duplex parameter is different from the manually set speed or duplex
parameter on the connected port.

e A port is set to autonegotiate, and the connected port is set to full duplex with no autonegotiation.

To maximize switch performance and ensure a link, follow one of these guidelines when changing the
settings for duplex and speed:

e Let both ports autonegotiate both speed and duplex.

e Manually set the speed and duplex parameters for the ports on both ends of the connection.

Note If a remote Fast Ethernet device does not autonegotiate, configure the duplex settings on the two ports
to match. The speed parameter can adjust itself even if the connected port does not autonegotiate. To
connect to a remote Gigabit Ethernet device that does not autonegotiate, disable autonegotiation on the
local device, and set the duplex and flow control parameters to be compatible with the remote device.

GBIC Security and Identification

Cisco-approved Gigabit Interface Converter (GBIC) modules have a serial EEPROM that contains the
module serial number, the vendor name and ID, a unique security code, and cyclic redundancy check
(CRC). When a GBIC module is inserted in the switch, the switch software reads the EEPROM to check
the serial number and the vendor name and ID, and to recompute the security code and CRC. The switch
shuts down the interface and displays a GBIC_SECURITY error message if the GBIC serial number, the
vendor name or ID, the security code, or CRC is invalid.

Note  If you are using a non-Cisco approved GBIC module, remove the GBIC module from the switch, and
replace it with a Cisco-approved module. For the GBIC modules supported on the switch, refer to the
release notes (http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900x1/index.htm).

After inserting a Cisco-approved GBIC module, use the show interface user EXEC command or the
show tech-support privileged EXEC command to verify the port status.
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Troubleshooting LRE Port Configuration

Table 10-5 lists problems you might encounter when configuring and monitoring the Long-Reach
Ethernet (LRE) ports on the Catalyst LRE switches. For additional information about what can affect
LRE connections, see the “Environmental Guidelines for LRE Links” section on page 8-6. For more
complete information on LRE ports and configuration, see Chapter 8, “Configuring LRE.”.

LRE command descriptions provide additional troubleshooting information. Refer to the switch
command reference.

Table 10-5 LRE Port Problems

Problem Suspected Cause and Suggested Solution
Amber LRE port LED |The switch and CPE device are unable to establish an LRE link using the selected profile.

¢ Change to a profile with a lower data rate (for example, use LRE-5 instead of LRE-15).

¢ Reduce the effect of stubs or bridge taps by terminating them with 300-ohm microfilters.

Excessive CRC errors ¢ A noisy environment (such as motors and power surges) is causing interference with the LRE
on an LRE link link.

— Change to a profile that has the interleaver feature enabled, such as the LRE-5, LRE-10,
LRE-15, LRE-10-1, LRE-10-3, or LRE-10-5 profile.

— Change to a profile with a lower data rate (for example, use LRE-5 instead of LRE-15) to
increase the noise margin.

e The LRE link length and quality are close to the limit of operation.
— Change to a lower profile (for example, LRE-5 instead of LRE-15).

— Reduce the effect of stubs or bridge taps by terminating them with 300-ohm microfilters.

High Reed-Solomon ¢ Interleaver is helping Reed-Solomon error correction to function correctly in a noisy
error count without environment. This situation means that the system is on the verge of generating CRC errors.
CRC errors

— Change to a profile that has the interleaver feature enabled, such as the LRE-5, LRE-10,
LRE-15, LRE-10-1, LRE-10-3, or LRE-10-5 profile.

— Change to a profile with a lower data rate (for example, use LRE-5 instead of LRE-15) to
increase the noise margin.

e The LRE link length and quality are close to the limit of operation.
— Change to a profile with a lower data rate (for example, use LRE-5 instead of LRE-15).

— Reduce the effect of stubs or bridge taps by terminating them with 300-ohm microfilters.
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Table 10-5 LRE Port Problems (continued)

Problem Suspected Cause and Suggested Solution

Ethernet performance |Interleaver introduces extra latency to increase noise margin.
degradation due to
excessive network
latency ¢ Change to a profile with a higher data rate to increase link bandwidth. This decreases the noise
margin.

e Adjust upper-layer network protocols to allow for high latency.

e Select a low-latency (LL) LRE profile, such as LRE-5LL, LRE-10LL, or LRE-15LL.

Note  Use the low-latency (LL) private profiles with care. The LL profiles have the LL feature
enabled and the interleaver feature turned off. The LL feature does not delay data
transmission, but it makes data more susceptible to interruptions on the LRE link.

All other profiles, public and private, have the interleaver feature enabled and the LL feature
disabled. The interleaver feature provides maximum protection against small interruptions
on the LRE link but delays data transmission. For more information about the LRE profiles,
see the “LRE Profiles” section on page 8-2.

LRE link quality Cross-talk between the LRE links is causing all links to degrade. Disable unused LRE ports by using
reduced in installations |the Ire shutdown interface configuration command.
with bundled cables
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Troubleshooting CMS Sessions

Table 10-6 lists problems commonly encountered when using CMS.

~

Note

Note

If your cluster has these member switches running earlier software releases and if you have
read-only access to these member switches, some configuration windows for those switches display
incomplete information:

— Catalyst 2900 XL or Catalyst 3500 XL member switches running Release 12.0(5)WC2 or
earlier

— Catalyst 2950 member switches running Release 12.0(5)WC2 or earlier
— Catalyst 3550 member switches running Release 12.1(6)EA1 or earlier

For more information about this limitation, refer to the release notes
(http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900x1/index.htm).

These switches do not support read-only mode on CMS:
— Catalyst 1900 and Catalyst 2820
— Catalyst 2900 XL switches with 4-MB CPU DRAM

In read-only mode, these switches appear as unavailable devices and cannot be configured from
CMS.

For more information about CMS access modes, see the “Access Modes in CMS” section on
page 2-33.

If you have configured the Terminal Access Controller Access Control System Plus (TACACS+) feature
on the switch, you can still access the switch through CMS. For information about how inconsistent
authentication configurations in switch clusters can affect access through CMS, see the “TACACS+ and
RADIUS” section on page 5-17.

For more troubleshooting and debugging information while using CMS, you can:

Use the Java plug-in console to display the status and actions of CMS. To display the console, select
Start > Programs > Java Plug-in Control Panel, and select Java Console.

From CMS (Reports > System Messages), you can display the system messages of the

Catalyst 2900 XL and Catalyst 3500 XL switches when they are in a cluster where the command
switch is a Catalyst 2950 switch running Release 12.1(6)EA2 or later or Catalyst 3550 switch
running Release 12.1(8)EAL1 or later. The System Messages option is not available from the
Catalyst 2900 XL and Catalyst 3500 XL switches. For more information about system messages,
see Appendix A, “System Messages.”
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Table 10-6 Common CMS Session Problems

Problem

Suspected Cause and Suggested Solution

A blank screen appears
when you click Cluster
Management Suite from
the Cisco Systems Access

page.

A missing browser Java plug-in or incorrect settings could cause this problem.

e CMS requires a Java plug-in to function correctly. For instructions on downloading and
installing the plug-in, refer to the release notes
(http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900x1/index.htm).

Note If your PC is connected to the Internet when you attempt to access CMS, the browser
notifies you that the Java plug-in is required if the plug-in is not installed. This
notification does not occur if your PC is directly connected to the switch and has no

internet connection.

e If the plug-in is installed but the Java applet does not initialize, do this:

— Select Start > Programs > Java Plug-in Control Panel. In the Proxies tab, verify that
Use browser settings is checked and that no proxies are enabled.

— Make sure that the port that connects the PC to the switch belongs to the same VLAN
as the management VLAN. For more information about management VLANSs, see the
“Management VLANSs” section on page 9-3.

The Applet notinited

message appears at the
bottom of the browser

window.

You might not have enough disk space. Each time you start CMS, the Java plug-in saves a copy
of all the jar files to the disk. Delete the jar files from the location where the browser keeps the
temporary files on your computer.

Refer to the release notes
(http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900x1/index.htm) for the required
Java plug-ins.

In an Internet Explorer
browser session, you
receive a message stating
that the CMS page might
not display correctly
because your security
settings prohibit running
ActiveX controls.

A high security level prohibits ActiveX controls, which Internet Explorer uses to launch the
Java plug-in, from running.

1. Start Internet Explorer.

From the menu bar, select Tools > Internet Options.

Click the Security tab.

Click the indicated Zone.

Move the Security Level for this Zone slider from High to Medium (the default).

S e B W DN

Click Custom Level and verify that the four ActiveX settings are set to prompt or enabled.

Configuration changes are
not always reflected in an
Internet Explorer 5.0
browser session.

Microsoft Internet Explorer 5.0 does not automatically reflect the latest configuration changes.
Make sure you click the browser Refresh button for every configuration change.
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Table 10-6 Common CMS Session Problems (continued)

Problem Suspected Cause and Suggested Solution

Link graphs do not display |Your browser security settings could be incorrect. If your browser security settings are correct,
information in an Internet |the lower right corner of your browser screen should have a green circle with a checkmark. If it
Explorer 5.0 browser. does not, follow these steps:

(For switches running 1. Start Internet Explorer.
sgftware carlier than 2. From the menu bar, select Tools > Internet Options.
Cisco I0S
Release 12.0(5)WC1) 3. From the Internet Options window, click Advanced.
4. Select the Java logging enabled and JIT compiler for virtual machine enabled check

boxes, and click Apply.
5. In the Internet Options window, click General.

6. In the Temporary Internet Files section, click Settings, click Every visit to the page, and
click OK.

7. In the Internet Options window, click Security, click Trusted Sites, and click Sites.
8. Deselect Require server verification.

9. Add the switches you want to manage by entering their URLs in the Add this web site to
the zone field. Click Add to add each switch.

A URL is the switch IP address preceded by http://. For example, you might enter:
http://172.20.153.36

10. After you have finished entering the URLSs for your switches, click OK.
11. While still in the Security tab of the Internet Options window, click Custom Level.
12. In the Security Settings window, select Java > Java permissions.

If you do not see Java > Java permissions, you need to reinstall the browser. When you
reinstall this browser, make sure to select the Install Minimal or Customize Your
Browser check box. Then, from the Component Options window in the Internet Explorer
5 section, make sure to click the Microsoft Virtual Machine check box to display applets
written in Java.

13. Click Custom, and click Java Custom Settings.

14. In the Trusted Sites window, click Edit Permissions.

15. Under Run Unsigned Content, click Enable, and click OK.
16. In the Security Settings window, click OK.

17. In the Internet Options window, click OK.
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Determining Why a Switch Is Not Added to a Cluster

If a switch does not become part of the cluster, you can learn why by selecting View > Topology.
Topology view displays the cluster as a double-switch icon and shows connections to devices outside the
cluster (Figure 10-1). Right-click the device (yellow label), and select Disqualification Code.

For a list of devices that are cluster-enabled, refer to the release notes
(http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900x1/index.htm).

Figure 10-1 Cluster View
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Copying Configuration Files to Troubleshoot Configuration

Problems

Step 1

Step 2

You can use the file system in Flash memory to copy files and to troubleshoot configuration problems.
This could be useful if you wanted to save configuration files on an external server in case a switch fails.
You can then copy the configuration file to a replacement switch and avoid having to reconfigure the
switch.

Enter the privileged EXEC dir flash: command to display the contents of Flash memory:

switch# dir flash:
Directory of flash:

2 -rwx 843947 Mar 01 1993 00:02:18 C2900XL-h-mz-112.8-SA
4 drwx 3776 Mar 01 1993 01:23:24 html

66 -rwx 130 Jan 01 1970 00:01:19 env_vars

68 -rwx 1296 Mar 01 1993 06:55:51 config.text

1728000 bytes total (456704 bytes free)

The file system uses a URL-based file specification. This example uses the TFTP protocol to copy the
file config.text from the host arno to the switch Flash memory:

switch# copy tftp://arno//2900/config.text flash:config.text

You can enter these parameters as part of a filename:

e TFTP

e Flash

e RCP

¢ XMODEM

Enter the copy running-config startup-config privileged EXEC command to save your configuration
changes to Flash memory so that they are not lost if there is a system reload or power outage. This
example shows how to use this command to save your changes:

switch# copy running-config startup-config
Building configuration...

It might take a minute or two to save the configuration to Flash memory. After it has been saved, this
message appears:

[OK]
switch#

[ 78-6511-09

Catalyst 2900 Series XL and Catalyst 3500 Series XL Software Configuration Guide g



Chapter 10 Troubleshooting |

I Troubleshooting Switch Software Upgrades

Troubleshooting Switch Software Upgrades

Table 10-7 lists problems commonly encountered when upgrading the switch:

Table 10-7 Problems Encountered When Upgrading the Switch

Problem Suspected Cause and Suggested Solution

Getting “Address Range” This error message appears when a 4-MB Catalyst 2900 XL switch is upgraded to an image that
error message and boot up |is not supported on this hardware. The switch in this case tries to load the image, but because
is failing. this switch is not capable of loading this image, the bootup process fails. This also happens in
cases when a 4-MB Catalyst 2900 XL switch is upgraded to an Cisco IOS 12.0 image.

Download the IOS image file by using X-Modem.

Getting “No Such File or This error message appears when the names of the bootable file and the actual file in the Flash
Directory” error message memory differ. This usually happens due to a mistyped filename when setting the boot
during bootup. parameters, during or after the upgrade.

Go to Setting BOOT Parameters at ROMMON (Switch: Prompt) to verify and set the BOOT
parameters correctly.

If setting the BOOT parameters to the correct filename does not resolve the issue, perform an
X-Modem upgrade, as the file in Flash memory could be corrupted or invalid.

Getting “Permission This error message appears when the boot parameters are not set correctly. In most of the cases,
Denied” error message when setting the boot parameters during or after the upgrade, the word flash: is mistyped or
during the bootup. completely missed.

Go to Setting BOOT Parameters at ROMMON (Switch: Prompt) to verify and set the BOOT
parameters correctly.

If setting the BOOT parameters to the correct filename does not resolve the issue, perform an
X-Modem upgrade, as the file present on the Flash memory could be corrupted or invalid.

Getting “Error Loading The error loading Flash message means that there is a problem loading the image in Flash
Flash” error messages. memory. The image could be corrupt or incorrect, or the image in Flash memory could be
missing. If the system is unable to load a software image in Flash memory, the system will load
the boot helper and bring up a switch prompt.

1. Enter the dir flash: command to verify if there is any bootable image on the Flash memory.
The file with the .bin extension is the bootable image on the Flash memory.

If you see a bootable image on the Flash memory, continue to Step 2. If you do not see any
bootable image in the Flash memory, download the IOS image file by using X-Modem.

2. Enter the set BOOT flash: name of 10S file command to set the boot variable to the
filename displayed in Step 1.

Note BOOT must be capitalized and make sure to include flash: before the filename.

3. Enter the boot command.

Note If the switch boots properly, enter the setting boot parameters global configuration
command to verify and set the BOOT parameters (if needed), and proceed to Step 4. If
the switch fails to boot properly, download the IOS image file by using X-Modem.

4. After setting the BOOT parameters, reload the switch by entering the reload privileged
EXEC command.

The switch boots up automatically with the correct image.
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Table 10-7 Problems Encountered When Upgrading the Switch (continued)

Problem

Suspected Cause and Suggested Solution

Failed software upgrade;
switch is resetting
continuously.

This might be due to a corrupt or incorrect image, or the image in Flash memory might be
missing. Following these steps to recover if the switch is in a reset loop after or during the
upgrade.

1. Connect the PC to the switch console port.

2. Press the Enter key a few times. Are you seeing a switch: prompt? If not, go to Step 3.
Otherwise, go to Step 4.

3. Disconnect the power cord. Hold down the mode button on the front of the switch, and plug
the power cord back in. All LEDs above all ports are green. Continue to hold down the
mode button until the light above port 1 goes out, and then release the mode button. The
prompt should be switch:.

4. Download the IOS image file using X-Modem.

After the upgrade, the
switch still boots up with
the old image.

This happens when either the BOOT parameters are not correct and the switch is still set to boot
from the old image or the upgrade did not go through properly.

Verify the BOOT parameters, and correct them if needed.
e If the BOOT parameters are correct, download the IOS image file using TFTP.
e If the switch still boots with the old image, download the IOS image file using X-Modem.

Switch not booting
automatically; needs a
manual boot at the
ROMMON (switch:

prompt).

The switch boot parameters might be set for manual boot. The switch can be set to boot
automatically by following these steps:

1. Use Telnet to access the switch, or connect the PC to the switch console port.
Enter the privileged EXEC mode by entering the enable command at the switch> prompt.
Enter the global configuration mode by entering configure terminal at the switch# prompt.

Enter no boot manual to tell the switch to boot automatically.

L I

Enter end to return to privileged EXEC mode, and save the configuration by entering the
write memory command.

6. Verify the boot parameters by entering show boot. Verify that Manual Boot is set to no.

[ 78-6511-09
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Recovery Procedures

The recovery procedures in this section require that you have physical access to the switch. Recovery
procedures include these topics:

e Recovering from Lost Member Connectivity, page 10-18
e Recovering from a Command Switch Failure, page 10-18
e Recovering from a Lost or Forgotten Password, page 10-24

e Recovering from Corrupted Software, page 10-26

Recovering from Lost Member Connectivity

Some configurations can prevent the command switch from maintaining contact with member switches.
If you are unable to maintain management contact with a member, and the member switch is forwarding
packets normally, check for these port-configuration conflicts:

e Member switches cannot connect to the command switch through a port that is defined as a network
port. For information on the network port feature, see the “Enabling a Network Port” section on
page 7-6.

e Member switches must connect to the command switch through a port that belongs to the same
management VLAN. For more information, see the “Management VLAN” section on page 5-18.

e Member switches connected to the command switch through a secured port can lose connectivity if
the port is disabled due to a security violation. Secured ports are described in the “Enabling Port
Security” section on page 7-11.

Recovering from a Command Switch Failure

You can prepare for a command switch failure by assigning an IP address to a member switch that is
command-capable, making a note of the command-switch password, and cabling your cluster to provide
redundant connectivity between all member switches and the replacement command switch. Hot
Standby Router Protocol (HSRP) is the preferred method for providing a redundant command switch to
a cluster. For more information, see the “HSRP and Standby Command Switches” section on page 5-12
and the “Creating a Cluster Standby Group” section on page 5-23. For a list of command-capable
Catalyst desktop switches, see the release notes
(http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900x1/index.htm).

If you have not configured a standby command switch, and your command switch loses power or fails
in some other way, management contact with the member switches is lost, and a new command switch
must be installed. However, connectivity between switches that are still connected is not affected, and
the member switches forward packets as usual. You can manage the members as standalone switches
through the console port or, if they have IP addresses, through CMS Device Manager.

These sections describe how to recover if a standby command switch was not available when the
command switch failed:

e “Replacing a Failed Command Switch with a Cluster Member” section on page 10-19
e “Replacing a Failed Command Switch with Another Switch” section on page 10-21

e “Recovering from a Failed Command Switch Without Replacing the Command Switch” section on
page 10-23

Catalyst 2900 Series XL and Catalyst 3500 Series XL Software Configuration Guide
m. 78-6511-09 |


http://www.cisco.com/univercd/cc/td/doc/product/lan/c2900xl/index.htm

| Chapter 10

Troubleshooting

Recovery Procedures

Replacing a Failed Command Switch with a Cluster Member

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Follow these steps to replace a failed command switch with a command-capable member of the same

cluster:

Disconnect the command switch from the member switches, and physically remove it from the cluster.

Use a member switch in place of the failed command switch, and duplicate its connections to the cluster

members.

Start a command-line interface (CLI) session on the new command switch.

You can access the CLI by using the console port or, if an IP address has been assigned to the switch, by

using Telnet. For details about using the console port, refer to the switch installation guide.

At the switch prompt, change to privileged EXEC mode:

Switch> enable
Switch#

Enter the password of the failed command switch.
From privileged EXEC mode, enter global configuration mode.

Switch# config terminal
Enter configuration commands, one per line. End with CNTL/Z.

From global configuration mode, remove previous command-switch information from the switch.

Switch(config)# no cluster commander-address

Return to privileged EXEC mode.

Switch(config)# exit

Switch#

Use the setup program to configure the switch IP information.

This program prompts you for an IP address, subnet mask, default gateway, and password. From
privileged EXEC mode, enter setup, and press Return.

Switch# setup

--- System Configuration Dialog ---
At any point you may enter a question mark '?' for help.
Use Ctrl-c to abort configuration dialog at any prompt.
Default settings are in square brackets '[]'.
Continue with configuration dialog? [yes/no]:

Enter Y at the first prompt.

Continue with configuration dialog? [yes/nol: ¥y

Enter the switch IP address, and press Return:

Enter IP address: ip address

Enter the subnet mask, and press Return:

Enter IP netmask: ip netmask

Enter Y at the next prompt to specify a default gateway (router):

Would you like to enter a default gateway address? [yes]l: ¥y

[ 78-6511-09
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Step14  Enter the IP address of the default gateway, and press Return.

IP address of the default gateway: ip address

Step15 Enter a host name for the switch, and press Return.

~

Note On a command switch, the host name is limited to 28 characters; on a member switch to 31
characters. Do not use -n, where n is a number, as the last character in a host name for any switch.

Enter a host name: host_name

Step16  Enter the password of the failed command switch, and press Return.

~

Note  The password can be from 1 to 25 alphanumeric characters, can start with a number, is case
sensitive, allows spaces, but ignores leading spaces.

Enter enable secret: secret_password

Step17 Enter Y to enter a Telnet password:

Would you like to configure a Telnet password? [yes] y

~

Note  The password can be from 1 to 25 alphanumeric characters, is case sensitive, allows spaces, but
ignores leading spaces.

Step 18  Enter the Telnet password, and press Return:
Enter Telnet password: telnet_password

Step19 Enter Y to configure the switch as the cluster command switch. Enter N to configure it as a member
switch or as a standalone switch.

S

Note If you enter N, the switch appears as a candidate switch in Cluster Builder. In this case, the
message in Step 20 does not appear.

Would you like to enable as a cluster command switch? y

Step20 Assign a name to the cluster, and press Return.

Enter cluster name: cls_name
__Eé

Note  The cluster name can be 1 to 31 alphanumeric characters, dashes, or underscores.

Step21 The initial configuration is displayed:

The following configuration command script was created:

ip subnet-zero

interface VLAN1

ip address 172.20.153.36 255.255.255.0
ip default-gateway 172.20.153.01
hostname host_name

enable secret 5 $1SM3pS$cXtAlkyR3/6Cn8/
line vty 0 15

password telnet_password
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Step 22

Step 23
Step 24

Step 25

Recovery Procedures

snmp community private rw
snmp community public ro
cluster enable cls_name

end

Verify that the information is correct.
e If the information is correct, enter Y at the prompt, and press Return.

e If the information is not correct, enter N at the prompt, press Return, and begin again at Step 1.

Use this configuration? [yes/nol: y

Start your browser, and enter the switch IP address that you entered in Step 11.

Display the CMS Home page for the switch, and select Enabled from the Command Switch drop-down
list.

Click Cluster Management Suite to display CMS.

CMS prompts you to add candidate switches. The password of the failed command switch is still valid
for the cluster, and you should enter it when candidate switches are proposed for cluster membership.

Replacing a Failed Command Switch with Another Switch

Step 1

Step 2

Step 3

Step 4
Step 5

Step 6

Follow these steps when you are replacing a failed command switch with a switch that is
command-capable but not part of the cluster:

Insert the new switch in place of the failed command switch, and duplicate its connections to the cluster
members.

Start a CLI session on the new command switch.

You can access the CLI by using the console port or, if an IP address has been assigned to the switch, by
using Telnet. For details about using the console port, refer to the switch hardware installation guide.

At the switch prompt, change to privileged EXEC mode:
Switch> enable

Switch#

Enter the password of the failed command switch.

Use the setup program to configure the switch IP information.

This program prompts you for an IP address, subnet mask, default gateway, and password. From
privileged EXEC mode, enter setup, and press Return.

Switch# setup

--- System Configuration Dialog ---
At any point you may enter a question mark '?' for help.
Use ctrl-c to abort configuration dialog at any prompt.
Default settings are in square brackets '[]'.
Continue with configuration dialog? [yes/no]:

Enter Y at the first prompt.

Continue with configuration dialog? [yes/nol: ¥y

[ 78-6511-09

Catalyst 2900 Series XL and Catalyst 3500 Series XL Software Configuration Guide g



Chapter 10 Troubleshooting |

I Recovery Procedures

Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

Step 15

Step 16

Enter the switch IP address, and press Return:

Enter IP address: ip address

Enter the subnet mask, and press Return:

Enter IP netmask: ip netmask

Enter Y at the next prompt to specify a default gateway (router):

Would you like to enter a default gateway address? [yes]: ¥y

Enter the IP address of the default gateway, and press Return.

IP address of the default gateway: ip address

Enter a host name for the switch, and press Return.

S

Note On a command switch, the host name is limited to 28 characters; on a member switch to 31
characters. Do not use -n, where n is a number, as the last character in a host name for any switch.

Enter a host name: host_name

Enter the password of the failed command switch, and press Return.

a~

Note  The password can be from 1 to 25 alphanumeric characters, can start with a number, is case
sensitive, allows spaces, but ignores leading spaces.

Enter enable secret: secret_password

Enter Y to enter a Telnet password:
Would you like to configure a Telnet password? [yes] ¥y
~

Note  The password can be from 1 to 25 alphanumeric characters, is case sensitive, allows spaces, but
ignores leading spaces.

Enter the Telnet password, and press Return:

Enter Telnet password: telnet_password

Enter Y to configure the switch as the cluster command switch. Enter N to configure it as a member
switch or as a standalone switch.

~

Note If you enter N, the switch appears as a candidate switch in Cluster Builder. In this case, the
message in Step 20 does not appear.

Would you like to enable as a cluster command switch? y

Assign a name to the cluster, and press Return.

Enter cluster name: cls_name

~

Note  The cluster name can be 1 to 31 alphanumeric characters, dashes, or underscores.
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Step 17

Step 18

Step 19
Step 20

Recovery Procedures

The initial configuration is displayed:

The following configuration command script was created:

ip subnet-zero

interface VLAN1

ip address 172.20.153.36 255.255.255.0
ip default-gateway 172.20.153.01
hostname host_name

enable secret 5 $1SM3pS$cXtAlkyR3/6Cn8/
line vty 0 15

password telnet_password

snmp community private rw

snmp community public ro

cluster enable cls_name

end

Verify that the information is correct.
e If the information is correct, enter Y at the prompt, and press Return.

e If the information is not correct, enter N at the prompt, press Return, and begin again at Step 1.

Use this configuration? [yes/nol: y

Start your browser, and enter the switch IP address that you entered in Step 7.
Click Cluster Management Suite to display CMS.

It prompts you to add the candidate switches. The password of the failed command switch is still valid
for the cluster. Enter it when candidate switches are proposed for cluster membership, and click OK.

Recovering from a Failed Command Switch Without Replacing the Command Switch

If a command switch fails and there is no standby command switch configured, member switches
continue forwarding among themselves, and they can still be managed through normal standalone
means. You can configure member switches through the console-port CLI, and they can be managed
through SNMP, HTML, and Telnet after you assign an IP address to them.

The password you enter when you log in to the command switch gives you access to member switches.
If the command switch fails and there is no standby command switch, you can use the command-switch
password to recover. For more information, see the “Recovering from a Command Switch Failure”
section on page 10-18.

[ 78-6511-09
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Recovering from a Lost or Forgotten Password

Step 1

Step 2
Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Follow the steps in this procedure if you have forgotten or lost the switch password.

Connect a terminal or PC with terminal emulation software to the console port. For more information,
refer to the switch installation guide.

S

Note  You can configure your switch for Telnet by following the procedure in the “Accessing the CLI”
section on page 3-8.

Set the line speed on the emulation software to 9600 baud.
Unplug the switch power cord.
Press the Mode button, and at the same time, reconnect the power cord to the switch.

You can release the Mode button a second or two after the LED above port 1X goes off. Several lines of
information about the software appear, as do instructions:

The system has been interrupted prior to initializing the flash file system. The following
commands will initialize the flash file system, and finish loading the operating system
software:

flash_init
load_helper
boot

Initialize the Flash file system:

switch: flash_init

If you had set the console port speed to anything other than 9600, it has been reset to that particular
speed. Change the emulation software line speed to match that of the switch console port.

Load any helper files:

switch: load_helper

Display the contents of Flash memory:

switch: dir flash:

The switch file system is displayed:

Directory of flash:

2 -rwx 843947 Mar 01 1993 00:02:18 C2900XL-h-mz-112.8-SA
4 drwx 3776 Mar 01 1993 01:23:24 html

66 -rwx 130 Jan 01 1970 00:01:19 env_vars

68 -rwx 1296 Mar 01 1993 06:55:51 config.text

1728000 bytes total (456704 bytes free)

Rename the configuration file to config.text.old.

This file contains the password definition.

switch: rename flash:config.text flash:config.text.old
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Step 10

Step 11

Step 12

Step 13

Step 14

Step 15

Step 16

Step 17

Recovery Procedures

Boot the system:

switch: boot

You are prompted to start the setup program. Enter N at the prompt:

Continue with the configuration dialog? [yes/no]: N

At the switch prompt, change to privileged EXEC mode:

switch> enable

Rename the configuration file to its original name:

switch# rename flash:config.text.old flash:config. text

Copy the configuration file into memory:

switch# copy flash:config.text system:running-config
Source filename [config.text]?
Destination filename [running-config]?

Press Return in response to the confirmation prompts.

The configuration file is now reloaded. Follow the next steps to change the password.

Enter global configuration mode:

switch# config terminal

Change the password:

switch(config)# enable secret <password>

or

switch(config)# enable password <password>

Return to privileged EXEC mode:

switch(config)# exit
switch#

Write the running configuration to the startup configuration file:

switch# copy running-config startup-config

The new password is now included in the startup configuration.

[ 78-6511-09
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Recovering from Corrupted Software

Step 1

Step 2
Step 3
Step 4

Step 5

Step 6

Switch software can be corrupted during an upgrade, by downloading the wrong file to the switch, and
by deleting the image file. In all these cases, the switch does not pass the power-on self-test (POST), and
there is no connectivity.

This procedure uses the XMODEM Protocol to recover from a corrupt or wrong image file. There are
many software packages that support the XMODEM protocol, and this procedure is largely dependent
on the emulation software you are using.

Connect a PC with terminal-emulation software supporting the XMODEM Protocol to the switch
console port.

Set the line speed on the emulation software to 9600 baud.
Unplug the switch power cord.
Reconnect the power cord to the switch.

The software image does not load. The switch starts in boot loader mode, which is indicated by the
switch: prompt.

Use the boot loader to enter commands, and start the transfer.
switch: copy xmodem:image filename.bin flash:image filename.bin

When the XMODEM request appears, use the appropriate command on the terminal-emulation software
to start the transfer and to copy the software image to Flash memory.
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